
© 2025 ManpowerGroup. All Rights Reserved.

ManpowerGroup
Employment Outlook Survey

REPORT
ITALIA

2
0

2
5

Q3
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*Net Employment Outlook results range from +100% to –100%

Executive 
Summary

Per l’ultima edizione del 

ManpowerGroup Employment

Outlook Survey, condotto in 42 Paesi, 

sono stati raccolti i punti di vista di 

40.671 datori di lavoro in merito alle loro 

intenzioni di assunzione nel terzo 

trimestre del 2025 e alle relative 

motivazioni.

24% Previsione netta di occupazione 

a livello globale
Calcolata sottraendo il numero di datori di lavoro che 

prevedono riduzioni dell’organico dal numero di quelli che 

prevedono di assumere.* Questo dato è in lieve calo rispetto 

al precedente trimestre (-1%) mentre è in crescita (+2%) 

rispetto al terzo trimestre 2024.

Il 37% delle aziende che prevedono 

assunzioni è in fase di ampliamento con un 

conseguente incremento delle posizioni aperte.

Settori con la più alta domanda di 

assunzioni a livello globale

Information 

Technology
Finance and 

Real Estate
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Previsioni 
sull’occupazione
Q3  2025 - Global
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Previsioni occupazionali 
per il 3° trimestre 2025 a 
livello globale

Utilizzato a livello internazionale come indicatore 

dei trend del mercato del lavoro, il dato relativo 

alle previsioni nette di occupazione, calcolato 

sottraendo la percentuale di datori di lavoro che 

prevedono riduzioni dell’organico da quelli che 

prevedono di assumere, si attesta al 24%.

Previsione netta di 

occupazione a 

livello globale
24%

prevede un aumento 

delle assunzioni

prevede una dimunzione 

dell’organico

non prevede variazioni

non lo sa

40%

16%

42%

2%
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L’espansione delle aziende 
è il traino dell’incremento 
occupazionale nel 
terzo trimestre

A livello globale i datori di lavoro intervistati hanno 

affermato che l'espansione della propria 

azienda è la ragione principale dell’incremento 

del personale, con una percentuale leggermente 

inferiore (-1%) rispetto al trimestre precedente.

37%

27%

25%

24%

24%

23%

21%

18%

15%

1%

Ruoli pro tempore (per posizioni 

vacanti prima dell’ultimo trimestre)

La crescita delle imprese 

crea più posti di lavoro

Impegnarsi in nuove attività 

richiede nuovi ruoli

Progetti specifici necessitano 

di staff dedicato

I progressi tecnologici 

richiedono più expertise

L'impegno per la diversità 

genera nuovi ruoli

Ruoli pro tempore (per posizioni 

vacanti nell’ultimo trimestre)

Occorrono le skill più aggiornate 

per rimanere competitivi

L'evoluzione delle esigenze 

di servizio crea nuovi ruoli

Altro
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In media, il 24% dei datori di lavoro 

dichiara di incrementare il proprio 

organico per soddisfare le esigenze dei 

progressi tecnologici, tendenza 

particolarmente marcata nelle aziende 

della regione Asia-Pacifico.

Regno Unito 51% Italia 25% Perù 21%

India 39% Israele 25% Messico 21%

Brasile 34% Norvegia 25% Guatemala 20%

Taiwan 33% Paesi Bassi 25% Ungheria 20%

U.A.E. 32% Austria 25% Colombia 19%

Hong Kong 31% Media Globale 24% Costa Rica 18%

Spagna 30% Finlandia 24% Argentina 17%

Slovacchia 30% Belgio 23% Svezia 15%

Singapore 30% Stati Uniti 23% Grecia 15%

Cina 29% Turchia 23% Portogallo 15%

Polonia 28% Australia 22% Cile 15%

Francia 26% Germania 22% Romania 13%

Canada 26% Irlanda 22% Repubblica Ceca 13%

Giappone 26% Svizzera 21% Panama 11%

Porto Rico 26%

Media 

Globale

24%

I progressi tecnologici continuano ad alimentare la creazione di 
posti di lavoro nella regione Asia-Pacifico
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Le sfide economiche 
influiscono sulla 
riduzione del personale

Per i datori di lavoro che prevedono una 

diminuzione del personale nel terzo trimestre, 

l'incertezza economica è indicata come la 

motivazione principale, seguita 

dall'adattamento ai cambiamenti del mercato.

34% 27% 24%

Sfide economiche che 

incidono sul personale

I cambiamenti del 

mercato riducono la 

domanda di alcuni profili

Riduzione del personale 

in adeguamento alla 

domanda attuale

22% 22%

Riorganizzazione o 

riduzione dell’organico

21%

Dimisssioni volontarie di 

personale senza sostituzioni

16%

Le diverse skill richieste 

hanno ridotto il fabbisogno 

di alcune posizioni

15%

Viene meno la 

richiesta di ruoli 

basati su progetti

3%

Altri motivi

Accorpamento dei ruoli 

conseguente 

all’ottimizzazione dei processi

21%

Ridotta necessità di alcuni 

ruoli a causa 

dell’automazione

7



Executive Summary Q3 Employment Outlooks Workforce Trends Industry Outlooks About the Survey

Le previsioni globali sono diminuite di 1 punto percentuale rispetto al precedente trimestre e sono in crescita 

(+2%) se confrontate con lo stesso periodo dell’anno scorso. 

Variazioni nel tempo
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Aspettative di assunzione da Luglio a Settembre per Paese

Previsioni nette di 

occupazione (NEO) 

destagionalizzate

24% Media Globale
NEO media

3% Argentina
NEO più bassa

48% U.A.E.
NEO più alta

U.A.E.* 48% Singapore 24% Israele 17%

India 42% Svezia 24% Italia 16%

Costa Rica 41% Svizzera 24% Portogallo 16%

Brasile 33% Australia 21% Slovacchia 16%

Paesi Bassi 30% Belgio 20% Austria 15%

Stati Uniti 30% Colombia 20% Giappone 15%

Guatemala 29% Germania 20% Repubblica Ceca 13%

Irlanda 29% Taiwan 19% Grecia 11%

Cina 28% Regno Unito 19% Polonia 11%

Messico 28% Cile 18% Spagna 11%

Canada 26% Finlandia 18% Hong Kong 8%

Norvegia 26% Porto Rico 18% Romania 6%

Panama 25% Turchia 18% Ungheria 5%

Perù 24% Francia 17% Argentina 3%

*Gli U.A.E.hanno partecipato al report dal Q3 2025, pertanto non sono ora disponibili dati storici e i dati qui presentati non sono destagionalizzati.
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Romania

6%

Le previsioni di 
maggiori e di 
minori assunzioni 
per il 3° trimestre

Le previsioni restano stabili in 

tutte le regioni, con aziende più 

propense ad assumere nella 

regione Asia-Pacifico (29%), 

seguite da quelle nell’area delle 

Americhe (27%) e da quelle in 

Europa e Medio Oriente (19%).

Previsioni maggiori di assunzioni

Previsioni minori di assunzioni

U.A.E.

48%
India

42%
Costa Rica

41%

Argentina

3%
Ungheria

5%
Grecia

8%
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Variazioni su base annua per Paese

Variazioni in 

percentuale delle 

previsioni nette di 

occupazione (NEO) 

destagionalizzate

+13% Israele
Maggior variazione positiva

-10% Svizzera
Minor variazione positiva

+2% Media Globale
Previsione media globale

Israele +13% Romania +3% Regno Unito -1%

India +12% Media Globale +2% Italia -2%

Svezia +12% Paesi Bassi +2% Portogallo -2%

Cile +11% Perù +2% Germania -3%

Porto Rico +10% Turchia +2% Guatemala -3%

Australia +9% Canada +1% Austria -4%

Costa Rica +7% Taiwan +1% Messico -4%

Brasile +6% Argentina 0% Polonia -4%

Panama +6% Cina 0% Spagna -4%

Repubblica Ceca +5% Colombia 0% Belgio -5%

Irlanda +4% Grecia 0% Finlandia -5%

Norvegia +4% Stati Uniti 0% Francia -7%

Singapore +4% Hong Kong 0% Ungheria -9%

Giappone +3% Slovacchia -1% Svizzera -10%
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Miglioramenti più significativi nelle previsioni per il Q3

I datori di lavoro in 20 Paesi riferiscono previsioni di assunzione maggiori rispetto allo stesso periodo dell’anno 

scorso, mentre si prevedono minori assunzioni in 15 Paesi e nessuna variazione in 6 Paesi. ​

Israele

+13%
India

+12%
Svezia

+12%

Miglioramenti su base trimestrale

Miglioramenti su base annua

Costa Rica

+9%
Brasile

+7%

Cile

+11%
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Aspettative di assunzione in base alle dimensioni dell’azienda

16%

meno di 10 
persone

16%

10 - 49 
persone

25%

50 - 249 
persone

26%

250 - 999 
persone

29%

1.000 – 4.999 
persone

27%

più di 5.000
persone
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Previsioni occupazionali a livello globale per settore

Le aziende del settore IT hanno indicato le previsioni più ottimistiche, con percentuali sostanzialmente in linea con il 

trimestre precedente (+1%) e in crescita rispetto allo stesso periodo dell’anno scorso (+7%).

36% 28%
26%

23% 23% 23%

15% 14% 14%

* Governo o servizio pubblico, organizzazioni no profit/ONG/benefiche/religiose; altro settore; altro sotto-settore di trasporti e logistica e settore automobilistico; enti formativi; agricoltura e pesca

Information 

Technology

Financials and

Real Estate

Energy and 

Utilities

Health Care 

and Life 

Sciences

Industrials and 

Materials

Transport, 

Logistics and

Automotive

Communication

Services

Consumer 

Goods and 

Services

Other* / None 

of the Above
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Previsioni occupazionali in Europa 
e Medio Oriente

In Europa e in Medio Oriente le aspettative di assunzione 

restano le più caute a livello globale (19%), con un calo di 1 

punto percentuale rispetto al secondo trimestre 2025 e 

invariate su base annua.

Nell’ambito di questa area geografica, le previsioni variano e i 

datori di lavoro negli U.A.E., nei Paesi Bassi e in Irlanda risultano 

essere i più propensi ad assumere. ​

A livello globale, si rilevano negli U.A.E. le maggiori intenzioni di 

assunzione nei settori Transport, Logistics & Automotive (64%), 

Energy & Utilities (57%), Consumer Goods & Services. Nel 

settore IT, le maggiori assunzioni sono previste in Norvegia, 

mentre la Repubblica Ceca prevede la percentuale più alta di 

assunzioni (57%) nel comparto Communication Services.

Maggiori intenzioni di assunzioni

Minori intenzioni di assunzioni

U.A.E.

48%

Paesi Bassi

30%
Irlanda

29%

Romania

6%
Ungheria

5%
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Maggiori intenzioni di assunzioni

Minori intenzioni di assunzioni

India

42%

Cina

28%

Hong Kong

8%
Giappone

15%

Singapore

24%

Previsioni occupazionali 
nell’area Asia-Pacifico

I responsabili delle assunzioni nella regione Asia-Pacifico 

hanno riferito le previsioni occupazionali più ottimistiche a 

livello globale (29%), con una flessione di 1 punto percentuale 

rispetto al trimestre precedente, ma in crescita di 6 punti 

percentuali rispetto al terzo trimestre 2024.​

India, Cina e Singapore continuano a dare le prospettive più rosee, 

mentre le previsioni più caute nell’ambito della regione arrivano da 

Hong Kong e dal Giappone.​

A livello globale, le aziende in India hanno riferito le prospettive più 

ottimistiche per il settore Financials and Real Estate (43%).​

16



Executive Summary Q3 Employment Outlooks Workforce Trends Industry Outlooks About the Survey

Maggiori intenzioni di assunzioni

Minori intenzioni di assunzioni

Previsioni occupazionali nelle 
Americhe

Per il terzo trimestre 2025, i Paesi del Nord, Centro e Sud 

America si collocano al secondo posto per quanto riguarda le 

previsioni di assunzione (27%), con una flessione del 7% 

rispetto al trimestre precedente.​​

I datori di lavoro in Costa Rica e Brasile hanno riferito la maggiore 

propensione ad assumere nel terzo trimestre 2025, mentre in 

Argentina, Cile e Porto Rico si prevedono le prospettive meno 

ottimistiche

A livello globale, le aziende in Costa Rica hanno riferito le migliori 

prospettive sia per il settore Healthcare and Life Sciences (62%) che 

per il settore Industrials and Materials (47%).

Costa Rica

41%

Argentina

3%

Cile

18%
Porto Rico

18%

Brasile

33%
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Previsioni 
sull’occupazione
Q3  2025 - Italia
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*Net Employment Outlook results range from +100% to –100%

Italy
 
Executive
  
Summary

16% Previsione netta di occupazione 

in Italia
Calcolata sottraendo il numero di datori di lavoro che 

prevedono riduzioni dell’organico dal numero di quelli che 

prevedono di assumere.* Questo dato è in calo (-2%) 

paragonato sia al precedente trimestre sia al terzo trimestre 

2024.

Il 32% delle aziende che prevedono 

assunzioni è in fase di ampliamento con un 

conseguente incremento delle posizioni aperte.

Settori con la più alta domanda di 

assunzioni in Italia

Information 

Technology

Financials and 

Real Estate
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Previsioni 
sull’occupazione in Italia 
per il 3° trimestre 2025

I datori di lavoro italiani, 

per il 3° trimestre 2025, 

prevedono assunzioni in 

crescita, registrando un 

NEO – Net Employment

Outlook del + 16%, al 

netto degli aggiustamenti 

stagionali, in leggera 

flessione (-2%) rispetto al 

trimestre precedente e 

rispetto allo stesso 

periodo dell’anno scorso.

Previsione netta di 

occupazione in 

Italia
16%

prevede un aumento 

delle assunzioni

prevede una dimunzione 

dell’organico

non prevede variazioni

non lo sa

29%

13%

56%

2%

20

Sud e 

Isole

+27%

Nord est 

+5%

Centro 

+11%

Nord ovest 

+16%
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Previsioni occupazionali per settore in Italia

Le aziende del settore Financials and Real Estate hanno indicato le previsioni più ottimistiche, con percentuali in 

crescita rispetto al trimestre precedente (+6%), ma in calo rispetto allo stesso periodo dell’anno scorso (-6%).

24%

22%

19% 18%
17%

14%

8% 7%
5%

* Governo o servizio pubblico, organizzazioni no profit/ONG/benefiche/religiose; altro settore; altro sotto-settore di trasporti e logistica e settore automobilistico; enti formativi; agricoltura e pesca

Information 

Technology

Financials and

Real Estate

Energy and 

Utilities
Health Care 

and Life 

Sciences

Industrials and 

Materials
Transport, 

Logistics and

Automotive

Communication

Services

Consumer 

Goods and 

Services

Other* / None 

of the Above
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L’espansione delle aziende 
è il traino dell’incremento 
occupazionale nel 
terzo trimestre

I datori di lavoro intervistati in Italia hanno 

affermato che l'espansione della propria 

azienda è la ragione principale dell’incremento 

del personale, con una percentuale leggermente 

inferiore (-1%) rispetto al trimestre precedente.

32%

29%

28%

25%

25%

25%

25%

13%

13%

1%

La crescita delle aziende 

crea più posti di lavoro

Impegnarsi in nuove 

attività richiede nuovi ruoli

Progetti specifici necessitano 

di staff dedicato

I progressi tecnologici 

richiedono più expertise

L'impegno per la diversità 

genera nuovi ruoli

Ruoli pro tempore (per posizioni 

vacanti nell’ultimo trimestre)

Occorrono le skill più aggiornate 

per rimanere competitivi

L'evoluzione delle esigenze 

di servizio crea nuovi ruoli

Altro

22

Ruoli pro tempore (per posizioni 

vacanti prima dell’ultimo trimestre)
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I cambiamenti del mercato 
influiscono sulla riduzione 
del personale
Per i datori di lavoro che prevedono una 

diminuzione del personale nel terzo trimestre, i 

cambiamenti del mercato sono indicati come la 

motivazione principale, seguiti dalle sfide 

economiche, dall’automazione e dall’accorpamento 

di ruoli conseguente all’ottimizzazione dei processi.

33% 27% 27%

Sfide economiche che 

incidono sul personale

I cambiamenti del 

mercato riducono la 

domanda di alcuni profili

Riduzione del personale in 

adeguamento alla domanda 

attuale

27% 21%

Riorganizzazione o 

riduzione dell’organico

18%

Dimisssioni volontarie di 

personale senza sostituzioni

16%

Le diverse skill richieste 

hanno ridotto il fabbisogno 

di alcune posizioni

15%

Viene meno la richiesta 

di ruoli basati su progetti

0%

Altri motivi

Accorpamento dei ruoli 

conseguente 

all’ottimizzazione dei processi

18%

Ridotta necessità di alcuni 

ruoli a causa 

dell’automazione
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Trend del mercato 
del lavoro in Italia
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16%

50%

27%

5%
1%

non lo sanessun 

impatto

minimo 

impatto 

impatto 

moderato

forte 

impatto

Quasi 7 aziende su 10 (66%) stanno preparando la loro 

strategia HR per far fronte all’impatto generato 

dell’invecchiamento della propria popolazione aziendale.

Prepararsi per l’impatto dei 
Boomer

66%

Consumer Goods 

& Services

58%

Financials & 

Real Estate

60%

Industrials & 

Materials

64%

Information 

Technology

72%

63%

Healthcare & 

Life Sciences

88%

Energy & 

Utilities

Communication 

Services

67%

Transport, Logistics

& Automotive

59%
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L’incertezza commerciale influisce sulle decisioni riguardo l’incremento del personale per oltre 7 aziende su 10 (72%). 

Assumere nuove risorse in una situazione 
di incertezza commerciale

*La percentuale risulta del 72% anziché del 73% per l’arrotondamento delle cifre decimali

1%

4%

23%

54%

19%forte impatto

impatto moderato

minimo impatto

nessun impatto

non lo sa

72%*

26
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Industrials 

& Materials

77%

Consumer Goods 

& Services

74%84%

Energy & 

Utilities

Health Care & 

Life Sciences

64%

Information 

Technology

79%

Communication 

Services

71%

Transport, Logistics, 

& Automotive

61%

Financials & 

Real Estate

68%
55%77%

Media Italia

72%

Centro
Asia-Pacific

L’incertezza commerciale impatta sulle decisioni dei datori 

di lavoro riguardo le nuove assunzioni soprattutto nell’area 

dell’Italia del centro e nel settore Energy and Utilities.

Aree volubili

27

75%

Sud e Isole Nord Est Nord Ovest

67%70%
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3%

2%

7%

23%

51%

13%

Automazione: alleviare il dolore o mascherare il problema?

In Italia un numero crescente di aziende è incentrato 

sull'automazione per gestire le attività ripetitive, con 

il 64% che ha riferito un aumento degli investimenti. Per 

le società la cui strategia HR è stata influenzata 

dall'invecchiamento della popolazione lavorativa e 

dall'incertezza commerciale, a livello globale gli 

investimenti sono saliti rispettivamente al 71% e al 

68%.

incremento significativo

incremento moderato

nessun cambiamento

riduzione moderata

riduzione significativa

non lo sa o NA

delle aziende in cui  

l’invecchiamento della 

ha un forte impatto sulle 

assunzioni

71% 68%

delle aziende in cui 

l’incertezza 

commerciale ha un forte 

impatto sulle assunzioni

delle aziende sta aumentando 

gli investimenti 

nell'automazione di attività o 

processi

64%

28
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80%

78%

77%

77%

77%

76%

74%

74%

73%

73%

IT & Data

Manufacturing

& Production

Sales & Marketing

Operations

& Logistics

Administration &

Office Support

Engineering

Sustainability &

Environmental

Human Resources

Front Office

Customer-Facing

ESG Risk, Advisory

& Governance

Cambiare le skill, cambiare le strategie

La maggior parte dei datori di lavoro (80%) prevede che i 

cambiamenti più significativi determinati dall’automazione 

interesseranno, nei prossimi cinque anni, i ruoli negli ambiti IT e 

di data processing.
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Previsioni per 
settore in Italia
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Communication Services 
Previsione netta di occupazione:

Communication Services

5%

25%

15%

13%

8%

Q3 2024

Q4 2024

Q1 2025

Q2 2025

Q3 2025

8%

31

IN CRESCITA

SU BASE ANNUA
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Consumer Goods and Services
Previsione netta di occupazione:

Consumer Goods 
and Services

17%

21%

20%

22%

18%

Q3 2024

Q4 2024

Q1 2025

Q2 2025

Q3 2025

18%

32

IN CRESCITA

SU BASE ANNUA
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7%

28%

41%

17%

Q3 2024

Q4 2024

Q1 2025

Q2 2025

Q3 2025

17%

Energy & Utilities

33

Energy & Utilities
Previsione netta di occupazione:

IN CRESCITA

SU BASE ANNUA



Executive Summary Q3 Employment Outlooks Workforce Trends Industry Outlooks About the Survey

Financials & Real Estate
Previsione netta di occupazione:

30%

28%

19%

18%

24%

Q3 2024

Q4 2024

Q1 2025

Q2 2025

Q3 2025

24%

Financials & Real Estate

34

IN FLESSIONE

SU BASE ANNUA
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IN FLESSIONE

SU BASE ANNUA

31%

4%

24%

17%

7%

Q3 2024

Q4 2024

Q1 2025

Q2 2025

Q3 2025

7%

Healthcare & Life Sciences

35

Healthcare & Life Sciences
Previsione netta di occupazione:
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18%

18%

19%

25%

14%

Q3 2024

Q4 2024

Q1 2025

Q2 2025

Q3 2025

14%
Industrials & Materials
Previsione netta di occupazione:

Industrials & Materials
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19%

41%

20%

34%

22%

Q3 2024

Q4 2024

Q1 2025

Q2 2025

Q3 2025

22%
Information Technology
Previsione netta di occupazione:

Information Technology
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IN CRESCITA

SU BASE ANNUA

Transport, Logistics
& Automotive

16%

17%

13%

15%

19%

Q3 2024

Q4 2024

Q1 2025

Q2 2025

Q3 2025

19%
Transport, Logistics & Automotive
Previsione netta di occupazione:
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Informazioni 

sull’indagine
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Dichiarazioni previsionali –
Il presente report contiene dichiarazioni previsionali, 

comprese quelle relative alla domanda di lavoro in 

determinate regioni, Paesi e settori, incertezza 

economica. Gli eventi o i risultati effettivi possono 

differire sostanzialmente da quelli contenuti nelle 

dichiarazioni previsionali a causa di rischi, incertezze e 

ipotesi. Tali fattori includono quelli presenti nelle 

relazioni della Società depositate presso la SEC, tra cui 

le informazioni indicate nella sezione "Fattori di rischio" 

della relazione annuale sul modulo 10-K per l'anno 

conclusosi il 31 dicembre 2024, qui incorporate per 

riferimento. ManpowerGroup declina qualsiasi obbligo 

di aggiornamento delle dichiarazioni previsionali o di 

altro tipo contenute nel presente documento, salvo nei 

casi previsti dalla legge.

Unicità – È ineguagliabile in termini di dimensioni, portata, longevità e aree di intervento. Il ManpowerGroup Employment

Outlook Survey è l'indagine previsionale sull'occupazione a livello mondiale più dettagliata, condotta chiedendo ai datori di

lavoro di fornire previsioni di assunzione per il trimestre successivo. Al contrario, altre indagini e studi si concentrano su dati 

retrospettivi per riferire accadimenti passati.

Indipendenza – L'indagine è condotta su un campione rappresentativo di datori di lavoro di tutti i Paesi e territori presi in 

considerazione. I partecipanti non provengono dalla base clienti di ManpowerGroup.

Solidità – L'indagine si basa su interviste a 40.671 datori di lavoro del settore pubblico e privato in 42 Paesi e territori, col 

fine di misurare le tendenze occupazionali previste ogni trimestre. Questo campione consente di effettuare analisi su specifici 

settori e regioni per fornire informazioni più dettagliate.

Focus – Da oltre sessant’anni l'indagine ricava tutte le informazioni da un'unica domanda: (ad esempio per il Q3): “Come 

prevede che cambierà l'occupazione totale nella sua sede nei prossimi tre mesi, da Luglio a fine Settembre 2025, rispetto al 

trimestre in corso?“

Metodologia – Le risposte all’indagine sono state raccolte nel mese di Aprile 2025. Le dimensioni dell'organizzazione e il 

settore sono standardizzati in tutti i Paesi e territori per consentire confronti internazionali.

Informazioni sull’indagine
Il ManpowerGroup Employment Outlook Survey, utilizzato a livello globale come indicatore economico 

fondamentale, è l'indagine previsionale sull'occupazione più completa del suo genere. La previsione netta di 

occupazione viene calcolata sottraendo dalla percentuale di datori di lavoro che prevedono un aumento delle assunzioni 

totali la percentuale di coloro i quali, invece, prospettano un calo delle assunzioni. L'indagine, lanciata nel 1962, deve il

suo successo a diversi fattori:
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Domande frequenti

Cosa si intende per previsione netta di occupazione (NEO)? 
La previsione netta di occupazione viene calcolata sottraendo dalla percentuale di datori di 

lavoro che prevedono un aumento delle assunzioni la percentuale di coloro i quali, invece, 

prospettano un calo dell'occupazione nella loro sede nel trimestre successivo. Si ha un dato 

positivo dal punto di vista delle previsioni nette di occupazione se, nel complesso, sono più 

numerosi i datori di lavoro che considerano di aumentare l’organico nei tre mesi successivi 

rispetto a quelli che intendono ridurre il numero di lavoratori.

Cos’è la destagionalizzazione e perché viene utilizzata nel 

ManpowerGroup Employment Outlook Survey?
La destagionalizzazione è un processo statistico che consente di presentare i dati 

dell’indagine senza l'impatto dovuto alle fluttuazioni delle assunzioni che normalmente si 

verificano nel corso dell'anno, di solito a causa di vari fattori esterni, come i cambiamenti 

climatici, i cicli produttivi tradizionali e le festività. La destagionalizzazione ha l'effetto di 

appianare i picchi e mitigare le depressioni dei dati per illustrare meglio i trend occupazionali 

sottostanti e fornire una rappresentazione più accurata dei risultati del ManpowerGroup

Employment Outlook Survey.

Come vengono selezionate le aziende per 

l'indagine? 
I datori di lavoro vengono selezionati in base ai tipi di aziende 

e organizzazioni che rappresentano. Intendiamo garantire un 

panel rappresentativo del mercato del lavoro nazionale di 

ciascun Paese partecipante; per questo, il campione di 

ciascun Paese è costruito in proporzione alla distribuzione 

complessiva dei settori industriali e alle dimensioni delle 

organizzazioni del Paese stesso.

Chi viene intervistato in ogni azienda?
La persona selezionata per partecipare all’indagine è colui o 

colei che ha una buona panoramica dei livelli di workforce e 

delle intenzioni di assunzione della propria organizzazione. 

Solitamente, si tratta del responsabile o di un manager HR. 

Tuttavia, nelle aziende più piccole, questa persona può essere 

un Direttore Generale o l’Amministratore Delegato.
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Visita www.manpowergroup.com per saperne di più.

Soluzioni ManpowerGroup per l’intero ciclo di vita HR

http://www.manpowergroup.com/
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Colors in the 2025 MEOS Reports

Do not change graphic or text colors from their 
original state.

– The 2025 MEOS PowerPoint templates use additional 

colors to enhance the overall design. 

– Backgrounds, charts and text colors have been 

purposefully applied and tested for accessibility.

– Do not add new tint shades, standard colors or recent 

colors when localizing the report.



Saving the MEOS Report as a PDF

Exporting your interactive PDF:

– Delete the Appendix (slides 32-36).

– Mac: File > Save a Copy… > File Format > PDF

– PC: File > Save a Copy… > More options > PDF

– Rename and save the document as PDF.

PC

Mac



Industry Vertical & Subsector Icons
Communication

Services

Consumer Goods & 

Services

Energy 

& Utilities

Financial 

& Real Estate

Healthcare 

& Life Sciences

Industrials & 

Materials

Information 

Technology

Transport, Logistics 

& Automotive

Entertainment Food Products Oil, Gas, & 

Consumable Fuels

Banks Healthcare Providers 

& Services

Construction 

& Engineering

IT Services Automotive

Diversified 

Telecommunication 

Services

Food & Staples 

Retailing

Energy Equipment 

& Services

Insurance Pharmaceuticals Industrials 

Manufacturing

Software Road & Rail

Media & Publishing Consumer Goods & 

Services 

Manufacturing

Electric Utilities Real Estate 

Management & 

Development

Healthcare Equipment 

& Supplies

Materials 

Manufacturing

Technology Hardware, 

Storage & Peripherals

Transportation 

Infrastructure

Wireless 

Telecommunication

Hospitality Industry Diversified Financial 

Services

Healthcare Technology Construction Materials Air Freight & Logistics

Multiline Retail Consumer Finance Machinery



Accountability 

and Reliability

Active Learning 

and Curiosity

Collaboration and 

Teamwork

Creativity and 

Originality

Critical Thinking 

and Analysis

Initiative-Taking Leadership and 

Social Influence

Reasoning and 

Problem-Solving

Resilience and 

Adaptability

Teaching and 

Mentoring

Digital Native

Soft Skill Icons

Administration / 

Office Support

Engineering ESG Risk / 

Advisory / 

Governance

Front Office / 

Customer Facing

HR IT / Data Manufacturing / 

Production

Operations / 

Logistics

Other Sales / Marketing Sustainability / 

Environmental

Technical Skill Icons



Argentina Australia Austria Belgium Brazil Canada Chile

China Colombia Costa Rica
Czech 

Republic
Finland France Germany

Greece Guatemala Hong Kong Hungary India Ireland Israel

Italy Japan Mexico Norway Panama Peru Poland

Portugal Puerto Rico Romania Singapore Slovakia Spain Sweden

Switzerland Taiwan
The 

Netherlands
Turkey U.K. U.S. U.A.E.

Country Flag Icons Global Average
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